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APPLICATION SERVICE PROVIDER AGREEMENT 

 
This Application Service Provider Agreement (“Agreement”) is made between Educational Leadership 
Solutions, Inc., a Mississippi corporation (“ELS”) and (“School”). 
 
ELS has developed and owns the ELS Product Suite (“Products”), internet-based applications which make data 
management easier and more effective for educators. 
 
School desires to use Products, and ELS desires to grant School a non-transferable, non-exclusive, and 
revocable license (“License”) to use Products.  School desires to so subscribe to the networks and accept the 
License, all pursuant to the terms and conditions provided below.  
 
The parties, ELS and School, agree to the following: 
 
1. ELS Services Provided.  ELS will provide Products via the website www.k12els.com, so that School users 
can utilize all Products features. Technical support will be provided via phone, 877-233-7833, and e-mail,  
support@k12els.com. 
 
2. License.  While this Agreement is in effect, ELS grants to School a non-transferable, non-exclusive, and 
revocable License to limited right to access and use of Products.  ELS owns the copyright on Products, and 
School has no right to copy Products, or to use Products except as provided herein. The grant of License 
herein is limited to School and its employees, and School is not authorized to give anyone other than School 
users access to Products or otherwise share Products with anyone outside School. ELS reserves the right to 
terminate this Agreement if this is not observed.   
 
3. Ownership.  School acknowledges that Products and all system files are and shall be solely owned by ELS, 
and ELS acknowledges that School shall own the data on Products. The foregoing notwithstanding, School 
grants ELS permission to manage data periodically for backup and maintenance. 
 
4. Term.  The term of this Agreement shall be for the remainder of this school year, commencing on the day of 
implementation and terminating on June 30 of the following school year.  The Agreement may be renewed for 
successive one (1) year terms, unless either party shall terminate this Agreement by notifying the other party 
in writing not less than thirty (30) days prior to the then current termination date. 
 
5. Fees.  Concurrently with the execution of this Agreement, School will pay ELS an initial startup fee for each 
product. In addition, there will be an annual renewal fee for Products if School decides to continue use of 
Products. 
 
The annual renewal fee for each year will be due and payable not later than each September 1.  ELS may 
increase the fees by written notice to School, which notice shall be given not later than forty-five (45) days 
prior to the expiration of the then current term.  
  
6. Choice of Law.  This Agreement shall be governed and construed by the laws of the State of Mississippi, and 
the parties consent to the jurisdiction of the courts within the State of Mississippi.  
 
7. Assignments.  School may not assign this Agreement to any other School. 
 
8. Entire Agreement and Notice.  This Agreement contains the entire understanding of the parties and may 
not be amended without the specific written consent of both parties. Any notice given under this Agreement 
shall be sufficient if it is in writing and sent by certified or registered mail to the parties at their respective 
addresses. 
 

 

http://www.k12els.com
mailto:ezsolutions@ezlessonplanner.com
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Introduction 
 

Welcome to the Educational Leadership Solutions, Inc. (ELS) Product Suite, web-based applications designed 
to make data management easier and more effective for educators. 
 
ELS, the designer of and service provider for this product suite, is a company dedicated to providing technolo-
gy solutions for educators.  It is our belief that for educational technology to be effective, it must be extremely 
user-friendly and easy to master (30 minutes or less).  We have designed our product suite to meet these  
criteria. 
 
This user manual has been designed to make your school’s implementation of our application efficient and 
effective.  It is our desire for all schools and school personnel to be 100% satisfied with our applications.   
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Getting Started 

Login 
 
Log in (go to www.k12els.com and click Login) 
and click Open next to EZ Assessment.  

Application Overview 
 
 
View Data 
 

EZ Assessment enables the user to analyze 
test data on three levels:  

1. Test Level (compiled data totals for 
the entire school on each test) 

2. Teacher Level (compiled data to-
tals for each teacher on each test) 

3. Student Level (individual student performance on each test) 
 
General test and compiled test data can be viewed for each test, including average points obtained, points 
possible, percentage correct, and reporting categories, or subskills. 
 
The filter menu enables users to filter data and display/hide columns of data.  Click on Set Filters button to 
view. 

 
Click on Apply Filters to apply selected filters. Users can also filter data by clicking on highlighted fields in 
the data table, which are hyperlinked (e.g. click 02/22/2011 for all tests that fall under that specified 
date). Column subtitles are sortable and data can be organized by clicking on column subtitles (e.g. click 
Avg. Pts. Obtained to sort data by corresponding numbers).  

http://www.k12els.com
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The EZ Assessment Teachers tab has the same functionality as the Tests tab.  On the Teachers tab,         
however, teachers are only able to see data for classes that they have tested or were credited with testing.  
On the Students tab, they can see all test data from previous and subsequent years for students that they 
have tested or were credited with testing as well as their currently scheduled students. 

 
 
The following features are functions that exist on all tabs (Tests, Teachers, and Students).  
 
 

Application Features 
 

View Reporting Category Data 
 

Click on the View Rpt. Cat. button to view reporting category data (e.g. subskills or strands). 

 
Once the button is clicked, reporting category data columns will appear.  

 
 
To view a description of reporting categories for a test, click on the key next to the test name.  

 



6 

 

 
Hyperlinked Sorts 
 

Hold your cursor over a column heading (e.g. Test) and click on it to sort the data by the selected column. 

 
Hyperlinked Filters 
 

Hold your curser over a highlighted field (e.g. ELS Benchmark Lang 6th) and click on it to sort the data by 
the selected field. 

 
Download Icon 
 

Click on the download icon at the right of the filter bar menu to export data to an Excel spreadsheet.  
Note: You must have Excel loaded to your computer in order to use this function. 

 

 
Printing Reports 
 

Hard copies of reports can be printed from any EZ Assessment screens.  To print a report, go to the Inter-
net Explorer Browser menu bar and select File>Print.   
 
If the report does not fit correctly onto the page, margins and page orientation (e.g. landscape vs. portrait) 
can be adjusted by going to File>Page Setup.  
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Multiple Pages of Data 

 
EZ Assessment data tables will show up to 100 rows of data on one page.  In instances where there are 
more than 100 records, the data will appear in multiple pages.  The page numbers will appear between 
the filter bar and column headings.  Multiple pages can be navigated by clicking on Previous, Next, or a 
specific page number.  

 

Test Tabs 
 

The Tests tab displays all years of compiled test results for the entire school.   

Column Key 
 Test: Test description  
 Test Date: Date in which the test was administered  
 # Tested: Number of students tested by the school 
 Avg. Pts. Obtained: Average points obtained score of all students 
 Avg. Pts. Possible: Average points possible for test 
 Percent%: Percent correct based on points obtained out of points possible  

 
Go to Teacher Data 
 

Click on the teacher icon at the left of any test data row to view a breakdown of teacher performance for 
that test.  This will take the user to the Teachers tab. 
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The Objective Report gives a  
detailed analysis of  test results based 
on test objectives.  The View Student 
Reports link gives users instant access 
to every student objective report.   

Test Analysis 
 

To the left of any test data row there is an Objective Report icon, an Item Analysis Report icon, and an 
Item Results Report icon which allows you to click to view a breakdown of information for each test. 
There is also a graph icon that allows you to view test data analysis by graph. 

The Item Analysis Report gives a break-
down of test results for each test question. 
 
By clicking details a new window opens 
that shows distribution percentage of  
student responses with student names.  
The bottom of the page displays a graph 
which breaks down student responses 
based on performance  

 

The Item Results Report shows test item 
results for each individual student who took 
the test. 
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Teacher Tab 
 

The Teachers tab displays all years of compiled test results for each teacher in a school.  

 
Column Key 

 Teacher: The teacher of record  
 Test: Test description  
 Test Date: Date in which the test was administered  
 # Tested: Number of students tested by the school 
 Avg. Pts. Obtained: Average points obtained score of all students 
 Avg. Pts. Possible: Average points possible for test 
 Percent%: Percent correct for given class based on average points obtained out of points possible  

 
 

Go to Student Data 
 

Click on the student icon at the left of any test data row to view a breakdown of student performance 
for that test.  This will take the user to the Students tab. 

 
Teacher Test Analysis 
 

To the left of any test data row there is an Objective Report icon, an Item Analysis Report icon, and 
an Item Results Report icon which allows you to click to view a breakdown of test results for each 
test for each corresponding teacher. There is also a graph icon that allows you to view test data  
analysis by graph for each corresponding teacher.  Go to Tests tab>Test Analysis in the User’s Guide to 
obtain a better understanding of each report. 
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Student Tab 
 

The Students tab displays all years of compiled test results for all tested and currently enrolled students.  

Column Key 
 Student: Student who took the test (Click on student’s name to filter for all of the selected stu-

dent’s test results.) 
 Teacher: The teacher who taught the class this content area 
 Test: Test description  
 Test Date: Date in which the test was administered  
 Pts. Obtained: Points obtained by student  
 Avg. Pts. Possible: Average points possible for test 
 Percent%: Percent correct for given student based on points obtained out of points possible  
 MCT2 PL: Proficiency level on most recent MCT2 

Viewing Student Data 
 

When attempting to view student data, you will be asked to narrow your search by selecting  
additional filters. The minimum criteria for a search are Test or Teacher or Student or Date. 
 
To view currently enrolled student data, choose Enrolled in the student filter and select Apply Filters. 

Once Enrolled has been selected in the student filter, the TESTED by Teacher and TESTED Students 
filters will be replaced by the ENROLLED by Teacher and ENROLLED Students filters.  The ENROLLED 
Students filter can be set to All Students  if the user wants to view test data for all students, or can be set 
to a teacher/course combo to view the students enrolled in that specific course. 
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Student Test Analysis 
 

To the left of any test data row there is an Objective Report icon, and an Item Analysis Report icon 
which allows you to click to view a breakdown of test results for each test for each corresponding  
student. There is also a graph icon that allows you to view test data analysis by graph for each  
corresponding student.  
 

 

The Item Analysis Report gives a 
breakdown of test results for each 
test question based on the student’s 
response. The analysis shows which 
answers were correct, and which 
response was chosen for each  
question. 
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Testing 
 
 
Create a Test 
 

Log into EZ Assessment and click on Create/Define a Test. To create a test using the Item Bank leave 
the first box set to Create (Test Bank). 
 

 
 Name the test. Select a content area, folder and lettering scheme. Click on Create a Test. 
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This will bring up the Test Definition Page; click the Add Questions button. 

 
Drag and drop the desired test questions onto the Test Definition Page. Click on Save periodically while con-
tinuing to create the test. 

 
Arrange the questions by dragging and dropping them into the desired location. If the questions have a pas-
sage attached to them, be sure to group them by their passages. 

When finished, click Save & Close.  To edit the test at a later time, click on the pencil icon next to the test name 
in the list. 
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Define a Test 
 
Log into EZ Assessment and click on Create/Define a Test. To create an answer key, click on the first drop 
down box to Define (External). Name the test. Select a content area, folder and lettering scheme. Click on  
Create Test. 
 

 
 

Enter the number of questions on the assessment in the Question Count box. Add the correct answer in the Key 
column and correlated objective from the Objective drop down menu for each test question. Click on Save  
periodically while continuing to enter the key. 

 
When finished, select Save & Close.  To edit the test at a later time, click on the pencil icon next to the test name 
in the list. 
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Pre Slug Test Forms 
 

1. Log into EZ Assessment, click on Pre Slug Forms under the Administer Test menu. 
2. Choose the Pre Slug criteria: 

a. If tests are organized by folder, choose the folder location.  Otherwise, leave Choose Folder set to 
ALL. 

b. Next to Choose Test, select the level the test was created on (District/School/Teacher) and then the 
test itself from the drop down menu.  

c. Select the teacher of record (test will be attributed to this person in the test data) from the Choose 
Testing Teacher.  If a teacher’s name is not in the list, add the teacher as a user using Site Admin 
Tools (see Support page at www.k12els.com for directions).  If there are duplicate teacher names, 
fix using Site Admin Tools. 

d. Next to Choose Testing, select Class or Students according to whether you want to add an entire 
class of students to the list or just one student at a time.  Then from the Choose Testing drop down 
menu select either a teacher’s class (if you chose Class) or an individual student (if you chose     
Students).  

e. Select a Period or leave set to N/A if period does not apply.  Period must be designated in order to 
view results by period.  

3. Click Add to List.  The list created below can be edited by deleting students from the list who will not be 
tested. 

4. Select corresponding form from the Form drop down menu.  Form number appears at the bottom left of 
Apperson test form.    

5. When your list has been created (we suggest printing no more than 200 test records at a time), click on 
Create PDF. 

6. Place blank forms into a laser printer and print.   
 
Important Note: 
ELS and/or Apperson Education Products will not be held liable for test forms damaged or rendered     
unusable by this pre-slugging process.  Please test carefully prior to printing a large batch of forms. 
We recommend first printing a few forms and scanning them to make sure they are properly read by the 
scanner and ELS Interface software prior to printing a large batch of forms. 

 

Pre-Slugging Do’s and Don’ts 
 

Pre-Slugging Do’s 
 
Do: Choose a form with the same answer pattern as the test. 

Do: Monitor printed forms at a minimum of every 20 forms.  Barcodes should be dark,       
crisp and centered horizontally on the blue line. 

Do: Use a laser printer. 

Do: Check one form from each new pack to make sure that it fits into the scanner tray. 

Pre-Slugging Don’ts 
 
Do Not: Separate the forms prior to printing. 

Do Not: Pre-Slug ‘A-D/F-J’ forms for an ‘A-D’ test (or vice-versa). 

Do Not: Print large batches of forms without monitoring the printed forms. 

Do Not: Print forms with an Ink Jet printer. 

Do Not: Use a printer or copier that is low on toner. 

http://www.k12els.com
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Scan and Upload Test Results 

1. To Scan Forms 
a. Open the ELS Interface software. 
b. Go to Scanner and select Scanner Settings, set the sequence number to ‘1’ and click on Print Batch/

Sequence #. 
c. Select your desired scoring mode from the menu bar (Test Scoring mode if using a key, Data Collection, 

the most common mode for ELS users, if not).  If you are doing Test Scoring method, place the key face 
up in the scanner tray and push the Scan/Pause button on the scanner. 

d. Place the test forms in the scanner tray, face up, and push the Scan/Pause button on the scanner. 
e. When scanning is complete, click Results Export to export your data.  Name and save the file in a location 

you can easily recall.  Note: Multiple teachers and/or test can be scanned in each batch if so desired. 
2. To Upload Data 

a. Click Upload to PM from the menu bar in ELS Interface which will take you to the Add New upload page 
in EZ Assessment.  If the web page is not already open the login screen will prompt you to login.   

b. Set the criteria for the upload file.  If your file contains the Test and Teacher ID’s, the criteria can be left 
From Upload File.  If you wish to overwrite a particular test and/or teacher id to all records in the file, 
select a test and/or teacher from the drop-down list(s).  If there are duplicate teacher names in the list, 
fix using Site Administrator Tools. 

c. Set the date that the test was administered.  Set the same date for all tests that you want grouped togeth-
er. 

d. Under Choose File, click on Browse and find, select, and open the file that you saved in step 1e, then click 
on Save. 

e. On the Upload Preview/Edit screen, edit Student Name, Teacher Name, Test Name, Period, or edit an-
swers. 

f. Choose one of the following options on the screen: Finish Upload, Preview Later, or Delete Upload. 
g. Once uploaded, review and edit the test upload by clicking on the pencil icon to the left of the upload in 

the list.  Once in the edit view, edit a student or teacher name by clicking on the pencil icon next to his/
her name. 

3.  To Upload Additional Test Files 
a. Return to ELS Interface, go to Scanner>Reset Scanner and respond No when asked whether you wish to 

save the session.   
b. Repeat steps 1 and 2 to upload additional test files. 

4. To Rescore an Upload 
a. If the test key is incorrect at the time of upload, edit the test key (see Define a Test) and save, then click 

on Rescore next to the upload record in the upload listing. 
b. If the test key has a question that you do not want included in the scored results, edit the test key (see 

Define a Test) and remove the check from Active for the item record and save.  Click on Rescore next to 
the upload record in the upload listing. 

Initial Setup 
 

1. Go to www.k12els.com  >Support>EZ Assessment and click on ELS Interface Download/Install and select ELS 
Scanning Interface Setup.exe to install the software.  Click Run and follow prompts to complete install. 

2. Open the ELS Interface software and install the scanner drivers for the Benchmark 3000. [If the scanner install 
dialogue screen doesn’t initially appear, go to Help>USB Drivers and install the ‘Benchmark 3000’ driver if the 
light is red.  If the light is green, the driver is already installed.] 

3. Close the ELS Interface software. 
4. Unpack the Apperson Benchmark scanner, put in the ink cartridges, and connect the scanner via USB cable, wait 

about 20 seconds for the add new hardware process, then open the ELS Interface software. 

Test Form Collection Directions (for teachers) 
 

1. Don’t use paper clips on forms. 
2. Don’t use any sticky notes on the test forms. 
3. Remove all blank forms or partially finished that you don’t want included in totals. 
4. Stack forms in order by test and teacher. 
5. If the front edges of forms are bent, stack the forms together and put a heavy weight (e.g. ream of paper or several 

textbooks) on top of the forms for a period of time. 
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EZ Assessment - Administrator Quick Start Guide 
 
 

 
 
Login 

Go to www.k12els.com, select ELS Client Login, enter user information, and select Login.  Then select the 
EZ Assessment icon. 

 
TAB DESCRIPTIONS 

Tests Tab 
 This tab displays all years of compiled test results for the entire school.  Users can view teacher results 

for the selected test by clicking on the teacher icon. 
 Reporting category data can be viewed by selecting the View Rpt. Cat. button. 
 Graphs comparing school performance to district performance, for district level tests, can be viewed by 

selecting the graph icon (located to the left on each row of data). 
 An Objective Report may be viewed by clicking on the O icon next to the corresponding test name.  This 

report displays number of items for each competency and the corresponding objectives.  The              
percentage correct is displayed for each competency and the objectives tested within that competency.  
Click on View Student Reports at the top of the page to view objective level results for each student. 

 An Item Analysis Report may be viewed by clicking on the I icon next to the corresponding test name.  
This report displays the percentage correct for each item and the matching objective as well as a         
distribution of student responses.  Click on details to view student responses on test items.   

 An Item Results Report may be viewed by clicking on the R icon next to the corresponding test name.  
This report prints complete test results for each student, four to a page. 

 
Teachers Tab 
 This tab displays compiled teacher data for all years and all tests.  Users can view student results for 

the selected teacher/test combination by selecting the student icon (located to the left on each row of 
data).  

 All functionality, reports, and graphs available on the Tests tab are also available on the Teachers tab.  
The data, reports, and graphs, however, are specific to each teacher. 

 
Students Tab 
 This tab displays all student level test data. 
 Student Type filter options include Tested or Enrolled.  When Enrolled is selected, the user can select All 

students, or select students on a specific teacher’s roll.     
 All functionality, reports, and graphs available on the Tests and Teachers tabs are also available on the 

Students tab.  The data, reports, and graphs, however, are specific to each student. 
 
TAB FEATURES 

 Hyperlinked Data: Data can be filtered by selecting highlighted fields in the data table (e.g. click on 
04/05/2011 to filter all test data for the selected test date).   

 Filter Menu: Data can also be filtered, and columns displayed, by using the filter menu (accessed by 
clicking on Set Filters).   

 Reporting Category Data: Reporting category performance (also referred to as subskills or strands) 
can be viewed for tests by clicking on the View Rpt. Cat. button. 

 Reporting Category Key: A gold key by each test name defines the columns for the corresponding  
reporting category. 

 
If you have any additional questions, contact ELS Customer Support at 877-233-7833 or support@k12els.com. 

Login:    Password:    School Code:     

http://www.k12els.com
mailto:support@k12els.com
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EZ Assessment - Teacher Quick Start Guide 
 

 

 
 
 

Login 
Go to www.k12els.com, select ELS Client Login, enter user information, and select Login.  Then select 
the EZ Assessment icon. 

 
TAB DESCRIPTIONS 

Tests Tab 
 This tab displays all years of compiled test results for the entire school.   
 Reporting category data can be viewed by selecting the View Rpt. Cat. button. 
 Graphs comparing school performance to district performance, for district level tests, can be viewed 

by selecting the graph icon (located to the left on each row of data). 
 An Objective Report may be viewed by clicking on the O icon next to the corresponding test name.  

This report displays number of items for each competency and the corresponding objectives.  The  
percentage correct is displayed for each competency and the objectives tested within that competency.   

 An Item Analysis Report may be viewed by clicking on the I icon next to the corresponding test name.  
This report displays the percentage correct for each item and the matching objective as well as a       
distribution of student responses.  

 
Teachers Tab 
 This tab displays compiled teacher data specific to the user, for all years and all tests.  
 All functionality, reports, and graphs available on the Tests tab are also available on the Teachers tab.  

The data, reports, and graphs, however, are specific to the user. 
 An Item Results Report may be viewed by clicking on the R icon next to the corresponding test name.  

This report prints complete test results for each student, four to a page. 
 The Objective Report on the Teachers tab includes the View Student Reports link at the top of the page.  

Click View Student Reports to view objective level results for each student. 
 The Item Analysis Report on the Teachers tab includes the details link.  Click details to view student 

responses on test items 
 

Students Tab 
 This tab displays all student level test data specific to the user. 
 Student Type filter options include Tested (students tested by the teacher) or Enrolled (only students 

currently taught by user).   
 All functionality, reports, and graphs available on the Tests and Teachers tabs are also available on the 

Students tab.  The data, reports, and graphs, however, are specific to each student. 
 
TAB FEATURES 

 Hyperlinked Data: Data can be filtered by selecting highlighted fields in the data table (e.g. click on 
04/05/2011 to filter all test data for that specific test date).   

 Filter Menu: Data can also be filtered, and columns displayed, by using the filter menu (accessed by 
clicking on Set Filters).   

 Reporting Category Data: Reporting category performance (also referred to as subskills or strands) 
can be viewed for tests by clicking on the View Rpt. Cat. button. 

 Reporting Category Key: A gold key by each test name defines the columns for the corresponding 
reporting category. 

 
If you have any additional questions, contact ELS Customer Support at 877-233-7833 or support@k12els.com. 

Login:    Password:    School Code:     

http://www.k12els.com
mailto:support@k12els.com
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Support Information 
 
Support 
Please contact us by phone (1-877-233-7833) or e-mail (support@k12els.com) with any questions you may 
have regarding our products. 
 
System Requirements 
The ELS Product Suite is a web application that is hosted by Educational Leadership Solutions, Inc.  Because it 
is an internet-based application, users (teachers and administrators) can access it from any computer that has 
access to the internet.  The applications can run on web browsers, including Internet Explorer, Mozilla Firefox, 
and Safari. 
 
Training 
The ELS Product Suite has been designed to require little or no formal training.  It is our goal to make the  
application user-friendly to the point that it can be mastered by following written instructions. 
 
All training documents, user manuals, and product demos are available at our website: www.k12els.com. 
 
Educational Leadership Solutions, Inc. also provides on-site training for schools who desire additional  
assistance with implementing the ELS Product Suite. 
 
 
ELS, Inc. 
Customer Support 
877-233-7833 
support@k12els.com 

mailto:ezsolutions@ezlessonplanner.com
http://www.k12els.com
mailto:support@k12els.com
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